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1. INTRODUCTION

The exercise will show how to model the flow of compressible fluid through
aturbine stage. The stage will be modeled as a two-dimensional, without taking into
account the walls of the steering wheel and the rotor, except for their blades. For further
simplification, the stage will consist of a single steering wheel and rotor, and the remaining
blades will be modeled using periodic boundary conditions. Air treated as ideal gas at a
speed of 10 m/s and a temperature of 100 °C flows into the turbine stage. The air outflows
to the environment at a pressure of 1 bar. The steering wheel (stator) is stationary while the
rotor rotates at 1000 rpm. The diagram of the analyzed case is presented in Fig. 1.
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Fig. 1. Diagram of the issue of flow through a two-dimensional turbine stage




2. FLOW THROUGH A TURBINE STAGE
2.1. GEOMETRY
Do the following:
1) Open Ansys Workbench and save project as Ex6 in catalog Ex6 (File->Save
As).
RULE OF THUMB NO. 1: Create a separate catalog for each project
RULE OF THUMB NO. 2: In the names of directories do not use: spaces,

special characters (e.g. @#$%"&* itp.) and polish marks
Product & CAD Configuration 19.2

- Reaction Workbench 19.2
RSM Cluster Monitoring 19.2
RSM Configuration 19.2
RSM Job Monitoring 19.2
SCDM 19.2

0 Uninstall ANSYS 19.2

"‘ User License Preferences 19.2

'A‘ Workbench 19.2

ANSYS, Inc. License Manager

Aparat
AutoCAD 2019 — polski (Polish) v

Autodesk

Bubble Witch 3 Saga

Candv Criich Sada Sana

m Y s £ 5

2) Select the Mesh module and open Spaceclaim. To do this, hold the left mouse
button (LMP) on the Mesh module and drag it to the Project Schematic field.
Then double-click LMP on Geometry to start the Spaceclaim program in which

the geometry will be created. Note that in the lower left corner of the screen
there is an inscription informing what program is running.
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3) In Assembly tab select File icon, and choose files Statorl.txt,

Rotorl.txt i Rotor2.txt.

Design  Display Measure  Facets

Repair

Prepare  Workbench  Detail Sheet Metal ~ Tools

KeyShot

Stator2.txt,

- o 7] & e s
|- e & il ﬂ?’ <]
[ File [Btandard N Select dhadd X
Part~ | & €& - <
Part Assemble Edit Configurations
designt open %
“ v <« MAGAZYN (1) » KompPraca » DYDAKTYKA > PRZEDMIOTY » WZPCP » D » Cwé v U Search Cwb »
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_Jl 3D Objects .Cwb_files.backup File folder
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- €] 09a1.pdf Foxit Reader PDF ...
‘ Downloads . o
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4) LMP on Select New Sketch ﬁ| to choose drawing plane.

o ||| & |||
——— Select New Skeich Plane

74 Click an object bo crent the
skedch grid along the obgect

) Press F for more help.

Select the X-Y plane by clicking the LMP of the stator or rotor profile as shown
below.

Ketch cunw

L
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5) Click Plan View |—| to rotate drawing plane parallel to the screen (you can do
it via Shift + v as well). 7
oL =

£e5.9509 ym B Dlsdhzéo:‘: design 50 that you are viewang the
. gnd
¥ Press F1 for more help, or F3 for a video.

6) Choose Select and then LMP indicate the upper stator profile. Then Ctrl + ¢ and
Ctrl + v to copy and paste an identical profile. There are now two profiles in the

same place.
Measure  Facets Repair  Prepare  Workbench  Detail Sheet Metal  Tools KeyShot
at 4 4 *Defauit’] v 4
a ¥ &
% ‘ Move 9PAdd /
t &
ssemble Edit Configurations

Select 1 sketch curve

7) Select Move, LMP indicate the upper stator profile, uncheck the option on the
left Maintain sketch connectivity and move the profile up 50 mm.
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F ) Drag a handle to move the selected curve
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X/
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Maintain orientation

Detach first
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Remember orientation k. Default v

8) Move the cursor closer to the end of the shifted curve and press the Shift key,
then use -15 mm for the horizontal dimension and 0 mm for the vertical
dimension.

9) Draw a vertical line 60 mm long.
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10) Select Trim Away " and remove the edge indicated in red and the unnecessary
vertical line.
NOO™TUYXN # % @ B Split Bod
rool-ie s Y YL T & e
SOV SZXZE O . 2 €& Project

Sketch Mode Edit Intersect




11) Draw a tangent line 200 mm long.

12) Draw a horizontal line 32 mm long starting at the trailing edge of the stator.

—{180°

13) Move the cursor to the center of the drawn line (a green triangle will appear)
and press Shift. For horizontal dimension, select 0 mm and for vertical 100 mm.
Then draw a vertical line 200 mm long.
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14) Draw a tangent arc to the copied stator line by selecting the command Tangent
Arc and LMP end of the line.
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15) Copy the curve shown.

16) Then move each curve downwards by 100 mm. To do this, select the Move

command and select Cartesian Coordinates on the left.
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17) Close the stator side profile and remove unnecessary edges.

J

18) Copy and move the bottom rotor curve by 50 mm.



19) Draw a tangent arc to the shifted curve.

20) Draw a tangent line 100 mm long.



21) Copy and move the curves 100 mm up.




22) Close the profile and remove unnecessary edges. If it turns out that you need to
remove the entire vertical line, you need to zoom in near the junction of the arch
with the vertical line and draw the missing piece of the arch.

.02
~180°

23) To exit the line drawing command, press Esc and LMP, click the Return to 3D
mode icon at the bottom of the screen.

[0]= 2=

Retum to 3D mode

O Activate the Pull tool in 3D
mode.

€ Press F1for more help.

24) Choose Fill and then Ctrl + a to select all curves. Then confirm Complete.
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25) Select LMP stator and rotor blades and remove them with the Delete key.

26) Using Pull extrude plane on 10 mm.

27) Create a plane as shown below.
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28) Select Split Body and select the body.



*an edge loop to use as a cutter.

29) Then LMP indicate the cuttin(-; Elane and exit the command usin(-) the Esc kez.
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30) Using Move move rotor by 60 mm.

NTOTLIXN # Q $ split Body 4 o @shel Cylinder
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Sketch Mode

Drag a handle to move the component

[l

31) Change the block names accordingly as Stator and Rotor.
Structure
4 [ |&) Designl*
v B Rotor
v (3 Stator
1) Plane
B[] Cuwves

32) Close Spaceclaim and save project in Workbench with the use of Ctrl + s.

2.2. NUMERICAL MESH
1) Open Ansys Meshing by double-click LMP Mesh
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2) In Ansys Meshing: 1) click Mesh, 2) change Physisc Preference into CFD, 3)
change Solver Preference into CFX, 4) click LMP Generate Mesh
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Details of "Mesh"

[=I| Display

Display Style |Use Geometry Setting

[=]| Defaults
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3) In Details of Mesh change Element Size into 2e-3 m



Details of "Mesh"

[=|| Display
Display Style |Use Geometry Setting
[=1| Defaults
Physics Preference | CFD
Solver Preference | CFX
Element Crder Linear
2,e-003 m|
Sizing
Quality
Inflation
Advanced
Statistics
4) Click RMB on Mesh and select Insert->Method
H project*
- (@ Model (€3)
""" v @@ Geometry

By 3K Coordinate Systems
# (& Connections

|
........ /D
Insert » <4 Method
Update 1@ Sizina
£ Generate Mesh M Co Method
] Control the algorithm and
Preview » A Ref ¥\ mesh types used to generate
Chions » @ Fac meshes on scoped entities.
$  Create Pinch Controls @ Me
(D Press F1 for help.
3 Group All Similar Children @ v
4 Clear Generated Data ® Pinch
Inflation
J-  Rename F2 =
: @ Mesh Edit
Start Recording
@  Mesh Numbering
Details oOf "MESh™ woia st i e e & Contad Maldh Group
| Display @ Contact Match
Display Style ] Use Geometry Setting
= Defaults 8) Node Merge Group
Physics Pfe—ferencgr ?FD ~$! Node Merge
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| | Element Size  2,e-003m
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Quality
Inflation
[+ Advanced
Statistics

5) LMP indicate both bodies and confirm Apply in Geometry
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Scoping Method | Geometry Selection
eome Apply Cancel
Definition
Suppressed No
Method Automatic

Element Order

Use Global Setting

6) Apply the following settings

Details of "MultiZone"” - Method

=

Scope

Scoping Method Geometry Selection

Geometry 2 Bodies

Definition

Suppressed Mo

Method FMultiZone

Mapped Mesh Type Hexa

Surface Mesh Method Program Controlled

Free Mesh Type Mot Allowed

Element Crder Use Glabal Setting

Srg/Trg Selection Automatic

Source Scoping Method | Program Controlled

Source Program Controlled

Sweep Size Behavior Sweep Element Size
Sweep Element Size | Default

Advanced

Preserve Boundaries Protected

Mesh Based Defeaturing | Off

Minimum Edge Length 1,2568e-002 m

Write ICEM CFD Files Mo

7) Click RMB on Mesh and select Insert->Sizing
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Quality
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Advanced
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8) Change the selection filter to edges (shortcut Ctrl + E) and indicate 8 green
edges as shown

9) Apply the following settings



Details of "EdgE Sizing" - Sizing DI I e e

[=I| Scope
Scoping Method Geometry Selection
Geometry 2 Edges
[=1| Definition
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Type Mumber of Divisinnsl
Mumber of Divisions §1
=] Advanced
Behavior Hardl
Capture Curvature Mo
Capture Proximity Mo
Bias Type Mo Bias

And press Generate Mesh.

10) Insert Sizing (face) on the surface of both blades as 5e-4 m.
11) Insert Inflation.
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Method
Sizing
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Face Meshing
Mesh Copy
Match Control
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Mesh E
Mesh N
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Apply inflation
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Contact

Node M| (i) Press F1 for help.
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Node Move

12) Select both bodies and confirm Geometry->Apply.

13) In Boundary select 4 blade surfaces and approve Apply. Generate a numerical

grid.




14) The last step is to name the bodies and surfaces. Give the following names
using Create Named Selection (if you do not remember how to use Create
Named Selection, check the previous instructions):

Stator body — Stator_domain
Rotor body — Rotor_domain
Stator inlet — inlet
Rotor outlet — outlet
Stator flat surfaces (lower and upper) — statorSym
Rotor flat surfaces (lower and upper) — rotorSym
Contact surface between stator and rotor — statorRotorInterface
Contact surface between rotor and stator — rotorStatorinterface
Right lateral surface of the stator body — statorPeriodicl
Left lateral surface of the stator body — statorPeriodic2
Right lateral surface of the rotor body — rotorPeriodicl
Left lateral surface of the rotor body — rotorPeriodic2
. Stator blade surface — statorBlade
n. Rotor blade surface — rotorBlade
15) Close Ansys Meshing and save project in Workbench.

2.3. NUMERICAL MODEL

1) Insert CFX
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To connect the Mesh module with CFX, grab the LMP Mesh (lower one) and
drag it to the Setup until the Transfer A3 box appears, and then release the LMP
- the connection has been created

- A v B

(.

2 Geometry ' ?%

3@ Mesh v, 3 |5 souton @
Mesh 4@ Resuts 2

CFX

Click RMB on Mesh and select Update
- A - |
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@ ) Edit.
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7 Update I
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Clear Generated Data
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Bli] Rename

Mesh
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Quick Help
Add MNote

Double-click Setup to run Ansys CFX
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2) Open Analysis Type by double-click LMP



hd [EI Mesh
> @] sys.cmdb
[# Connectivity
hd [El Simulation
~ [ Flow Analysis 1
v || Default Domain
M ¥ Default Domain Default

Apply the following settings and confirm OK.

Outline Analysis Type
Details of Analysis Type in Flow Analysis 1
Basic Settings
AMSYS MultiField Coupling

Option Maone

Analysis Type

Optian Steady smg

3) Delete Default Domain
v [él Mesh
> @) sys-11.cmdb
> % Connectivity
v @ Simulation
v @] Flow Analysis 1
@ Analysis Type

v _ = Default Domai ﬁ

MPE pefault D i
«
MPE pefault Fi B] Mesh Statistics
MPE pefault Fi
v #% Interfaces Insert ¢
M2 pefault Fi
e Render i
8I»::f. Solution Units Show
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4) Create rotor domain



and apply below settings



Outline Domain: rotor
Details of rotor in Flow Analysis 1

Basic Settings Fluid Madels Initialization Solver Cantral

Location and Type

Location Rotator_domain
Domain Type Fluid Domain
Coordinate Frame Coord 0

Fluid and Partide Definitions. ..

Fluid 1
Fluid 1
Option Material Library
Material Il Air Ideal Gas I
Marphology
Ciption Continuous Fluid

[ ] Minimum Volume Fraction

Domain Models
Pressure

Reference Pressure | 1 [atm]

Buoyancy Model
Option Mon Buoyant

Domain Motion

QOption Rotating

Angular Velocity 1000 [rev min<-1]
[] alternate Rotation Model
Axis Definition
Option Coordinate Axis
Rotation Axis Global %

Mesh Deformation

QOption Maone



COutline Domain: rotor

Details of rotor in Flow Analysis 1

Basic Settings Fluid Models Tnitialization

Heat Transfer

Cption Total Eneray

Indl. Vizcous Work Term

Saolver Control

Turbulence
Option Shear Stress Transport
Wall Function Automatic

igh Speed (compressible) Wall Heat Transfer Model
[ ] Blended Mear Wall Treatment (Beta)
[ ] Turbulent Flux Closure for Heat Transfer
[ ] Transitional Turbulence
Advanced Turbulence Control

Combustion
Option
Thermal Radiation

Option

Mone

Maone

[ ] Electromagnetic Model

5) Similarly, create a domain stator and apply below settings

BEEHHH

|



Cutline Domain: stator
Details of stator in Flow Analysis 1

Basic Settings Fluid Madels Initialization Solver Cantral

Location and Type
Location || Stator_domain w
Domain Type Fluid Domain -
Coordinate Frame Coord 0 -
Fluid and Particle Definitions. .. =
Fluid 1
[
X
Fluid 1 B
Cption Material Library -
Material I Ajr Ideal Gas I e
Marphology =
Cption Continuous Fluid -
[ ] Minimum Valume Fraction
Domain Models
Pressure B
Reference Pressure |1 [atm]
Buoyancy Model =
Option Mon Buoyant =
Domain Motion =
Mesh Deformation =

Option MNone



Outline Domain: stator
Details of stator in Flow Analysis 1

Basic Settings Fluid Models Initialization Solver Contral

Heat Transfer =

Option Total Energy -

Ind. Viscous Work Term

Turbulence =
Option Shear Stress Transport =
Wall Function Automatic -

igh Speed (compressible) Wall Heat Transfer Model

[ ] Blended Mear Wall Treatment (Beta)
[ ] Turbulent Flux Closure for Heat Transfer
[ ] Transitional Turbulence
Advanced Turbulence Control
Combustion =
Option Mone 7
Thermal Radiation =
Option Marne -
[ ] Electromagnetic Madel

6) In stator domain

&P vﬂvi{-vﬁ

! in rotor
.
in stator

And apply

Outline Boundary: inlet
Details of inletin stator in Flow Analysis 1

Basic Settings Boundary Details Sources Plot Options

Boundary Type Inlet -

Location inlet e

[] Coordinate Frame




Cutline Boundary: inlet
Details of inlet in stator in Flow Analysis 1

Basic Settings I Boundary Details I Sources  Plot Options

Flow Reqgime
Option Subsonic

Mass And Momentum

Option Mormal Speed

Mormal Speed I 10 [m 5-1] I

[ ] Acoustic Reflectivity (Beta)

Turbulence

Option Medium (Intensity = 5%G)
Heat Transfer

Option Total Temperature

Total Temperature IIEIEI [C] I

7) In stator create boundary condition statorBlade with definition

Outline Boundary: statorBlade
Details of statorBlade in stator in Flow Analysis 1

Basic Settings Boundary Details Sources
Boundary Type

Location I statorBlade I

[ ] Coordinate Frame

Qutline Boundary: statorBlade
Details of statorBlade in stator in Flow Analysis 1

Basic Settings | Boundary Details | Sources

Mass And Momentum
Option Mo Slip Wall

[ ] wall velocity
[] Turbulent wall Functions (Beta)

Wall Roughness

Option Smoath Wall
Heat Transfer
Option Adiabatic

8) In stator create boundary condition statorSym with definition



Outline Boundary: statorSym
Details of statorSym in statorin Flow Analysis 1

Basic Settings

Boundary Type I Symmetry I il

ot |

Location I statorSym I

9) In rotor create boundary condition rotorSym with definition
Qutline Boundary: rotatorSym
Details of rotatorSym in rotor in Flow Analysis 1

Basic Settings
Boundary Type ISymmetry I =
Location I rotatorsym I w |
10) In rotor create boundary condition rotorBlade with definition
Cutline Boundary: rotorBlade
Details of rotorBlade in rotor in Flow Analysis 1
Basic Settings Boundary Details Sources
Boundary Type I Wall I -
Location I rotorBlade I w
[ ] coordinate Frame
Frame Type Rotating =
Cutline Boundary: rotorBlade
Details of rotorBlade in rotor in Flow Analysis 1
Basic Settings I Boundary Details I Sources
Mass And Momentum
Option Mo Slip wall hd
] wall velodty
[ ] Turbulent Wall Functions (Beta)
Wall Roughness
Option Smooth Wall -
Heat Transfer
Cption Adiabatic hd
11) In rotor create boundary condition outlet with definition
Qutline Boundary: outlet
Details of outletin rotorin Flow Analysis 1
Basic Settings Boundary Details SOUrces Flot Options
Boundary Type IDuﬁet I -
Location I outlet I w

[ ] Coordinate Frame

Frame Type Stationary



Outline Boundary: outlet
Details of outlet in rotor in Flow Analysis 1

Basic Settings I Boundary Detzils I Sources Plot Options

Flow Regime

Option Subsonic

Mass And Momentum

Option Average Static Pressure
Relative Pressure IU [Fal I
Pres. Profile Blend |U.05

[] Implicit Pressure Averaging (Beta)
[] Acoustic Reflectivity (Beta)

Pressure Averaging

Option Average Over Whole Outlet

12) Create interface named rotorStatorinterface

P, b A REE

TE Insert Domai.. ? >

Mame |rutor513tor1nter1'ace|

Corcel

And apply the following



Cutline Domain Interface: rotorStatorinterface B
Details of rotorStatorInterface in Flow Analysis 1

Basic Settings Additional Interface Models Mesh Connection
Interface Type Fluid Fluid -

Interface Side 1

Domain (Filter) | rotor | v |

Region List I rotatorStatorInterface I e |
Interface Side 2

Domain (Filter) I stator I w |

Reqgion List I statorRotorInterface I A |

Interface Models

Option General Connection b
Frame Change/Mixing Model =
Option IFrozen Rotor I b

] Rotational Offset
PFitch Change =
Option I Automatic I 7

13) Create periodic boundary conditions in the domain stator using interface named
statorPeriodic
Dutline Domain Interface: statorPeriodic X
Details of statorPeriodic in Flow Analysis 1

Basic Settings Mesh Connection
Interface Type Fluid Fluid -

Interface Side 1

Domain {Filter) I stator I v |

Region List I statorPeriodicl I w |

Interface Side 2

Domain (Filter) I stator I ~ |

Region List I statorPeriodic2 I ~ |

Interface Models

Option IF‘.oEtinnaI Periodicn_:rl -

Axis Definition

Option Coordinate Axis -

Rotation Axis IGIubaI X I 7




Dutline Domain Interface: statorPeriodic B
Details of statorPeriodic in Flow Analysis 1

Basic Settings I Mesh Connection I

Mesh Connection Method

Mesh Connection =
Option |car | v
[] Intersection Control

14) Create periodic boundary conditions in the domain rotator using interface
named rotorPeriodic
Outline Domain Interface: rotatorPeriodic B8
Details of rotatorPeriodic in Flow Analysis 1

Basic Settings Mesh Connection
Interface Type Fluid Fluid -

Interface Side 1

Domain (Filter) || rotor I e |
Region List || rotatorPeriodicl I |v |
Interface Side 2
Domain (Filter) || rotor I e |
Region List || rotatorPeriodic2 I e |
Interface Models
Option I Rotational Periudi::ityl =
Axis Definition
Option Coordinate Axis hd
Rotation Axis I Global X I A
COutline Domain Interface: rotatorPeriodic X

Details of rotatorPeriodic in Flow Analysis 1

Basic Settings I Mesh Connection I

Mesh Connection Method

Mesh Connection =
Option | car | v
[ ] Intersection Contral

15) Create a monitoring point containing expression with the following definition:
torque()@rotorBlade
16) Open Solver Control and apply



Cutline Solver Control
Details of Solver Controlin Flow Analysis 1

Basic Settings Equation Class Settings Advanced Options
Advection Scheme
Option High Resolution -
Turbulence Mumerics =
Option High Resolution -
Convergence Control
Min. Iterations 1 | ]
Max. Tterations 1000 | O
Fluid Timescale Control =
Timescale Control Auto Timescale -
Length Scale Option Conservative -
Timescale Factor 1.0
[] Maximum Timescale
Convergence Criteria
Residual Type RMS -
Residual Target || 1e-6
|:| Conservation Target
[ ] Elapzed wall Clock Time Control
Interrupt Control =
Oiption Any Interrupt =
Convergence Conditions =
Cption Default Conditions b
User Interrupt Conditions =
[

X

17) Close Ansys CFX.

2.4. SOLVER

1) Double-click Solution to run Ansys CFX Solver Manager
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I : Starting CFX-SolverManager... I
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2) Apply the following settings and press Start Run. The program will perform
calculations. Wait a few moments for the message to complete the calculations.




& Define Run ? *

Solver Input File NCwS\CwS_files\dpO\CFX\CFX\CRX.def | | |5
Global Fun Settings
Run Definition Initial Values
Run Settings

Type of Run Full

Double Precisiunl
[] Large Problem

Parallel Environment =
Run Mode Intel MPI Local Parallel -
Host Name Partitions

desktop-1erkcpo 4

[ ] show Advanced Controls

Start Run Save Settings Cancel

3) Calculations take about 5 minutes. Convergence is achieved after about 150
iterations. Watch the individual tabs as they change. Pay particular attention to
the User Point tab, where the torque is shown on the rotor blade profile. Steady
state will be reached when the curve stabilizes, which will occur after about 50
iterations. Additional iterations should be performed until all residuals have
stabilized. To stop, press the Stop button at the top of the screen and confirm
Yes.



Momentum and Mass Heat Transfer Turbulence (KO) Wall and Boundary Scale User Points [x] Qut File

L.0e+00 —
] GEI Intersection 0.0 %
] File Reading 0.1%
Search Calculations 0.1 %
1 Varisble Updates 21.0 %
File Writing 0. %
1.0e-01 Miscellaneous 13.5 &
] Total
Bl Solver Run Finished Normally 7 X pun
e ] NS ———
| CFX_001 has completed normally.
Run conduded at: sob. maj 23 20:19:38 2020
] 4 @ resusarein
E I:/KompPraca/DYDAKTYKA/PRZEDMIOTY /WZPCP /D/Cw6/Cw6_files/dp0/CFX-3/CFX/CFX_001.res . 17 081 )
2 1.0e03 htes:  Seconds )
2
E 1 Open this workspace now
1 partitions.
Efd 6F SolUtIcH STage-
1.0e-04 | &
1 | The results from this run of the ANSYS CFX Solver have been
| written to
| I:/KompPraca/DYDAKTYKA/PRZEDMIOTY/WIBCE/D/Cué/Cué_pending/dpd_CF.
1.0e-05 - | _3_Solution_3/CFX_001.res
| For CFX runs launched from Workbench, the final locations of
1.0e-06 — | directories and files generated may differ from those shown.
T T T T
i 50 100 150
Accumulated Time Step
This rim af rthe ANSYS CFE Snlwer has finished

4) After 'completing the calculations, the program will display a confirmation
message.
5) Confirm OK and close Ansys CFX Solver Manager. Save project in Workbench.
2.5. RESULTS

1) Double-click LMP Results to run Ansys CFD Post and see the results.
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2) For better observation of the results use Default Transform




Tamy e omm—rEm mme e

W User Locations and Plots
*

i+. Default Transform

L Default Legend View 1

D@- Plane 1

'*2 Vector 1
B wireframe
hd @ Report W

Details of Default Transform

Definition

Insmndng Info From Domain
Mumber of Graphical Instances I 3 I
[ ] Apply Rotation =

4k

Axis Definition
Method Principal Axis

i

Axis

Instance Definition

Full Cirdle
Determine Angle From Instances in 380
Mumber of Passages 12 =

4k

Passages per Component 1

I Apply Translation I =
Translation |III IEI. 1 IIZI

[ ] apply Reflection =
Method From Plane

Plane

3) Create a plane perpendicular to the profile (parallel to the sym surface) and
show the contours

Total temperature
Turbulence Kinetic Energy
Turbulence Eddy Dissipation
I. Yplus
4) Using areaAve function calculate in a table:
a. Average inlet speed value
b. Value of the mass flow at the inlet and outlet

a. Pressure

b. Absolute Pressure

c. Total Pressure

d. Relative velocity — Velocity
e. Absolute velocity — Velocity in Stn Frame
f.  Mach Number

g. Density

h. Temperature

i.

J.

k.



c. Value of average temperature on the surface of the blades

d. Average value of Yplus variable on the surface of the blades
5) Show the contours of the Yplus variable on the surface of the blades
6) Display the streamlines on the previously created plane
7) * Calculate the power generated in the turbine stage

3. RESULTS TO BE INCLUDED IN THE REPORT
1) Contours in a plane parallel to the surface sym:
Pressure
Absolute Pressure
Total Pressure
Relative velocity — Velocity
Absolute velocity — Velocity in Stn Frame
Mach Number
Density
Temperature
Total temperature
Turbulence Kinetic Energy
Turbulence Eddy Dissipation
I. Yplus
2) In table show the results of:
a. Average inlet speed value
b. Value of the mass flow at the inlet and outlet
c. Value of average temperature on the surface of the blades
d. Average value of Yplus variable on the surface of the blades
3) The contours of the Yplus variable on the surface of the blades
4) Streamlines
5) Answer the question: What is Yplus? Based on the analysis of the Yplus variable
value, whether the SST turbulence model used was selected correctly?

T STQ e o0 oW

4. OPTIONAL TASKS (NOT REQUIRED)
1. Perform calculations using a different turbulence model and compare the results.
2. Return to the Meshing module and perform calculations for: a) thinner numerical
grid, b) denser numerical grid (especially on the surface of the blades). Check how
it affects the calculations and the value of the Yplus variable and the torque.

5. REFERENCES
[1] I.H. Johnston, Dianne Smart, An experiment in turbine blade profile design,
Ministry of technology Aeronautical Research Council, London, 1967.



